SerialEM Protocol

cryo collection
Fred Hutch

Glacios




What you’re starting with:

 Atlases of all of your grids
* Grid you want to collect on chosen

* Screening performed in Leginon so you know what
thickness of ice you want to target

 WARP started on your Leginon screening



Insert grid you want to imag

1. Microscope computer

1.

Autoloader tab

Click “number”
Click ”"Load”

Make sure “Turbo
Auto Off” is selected

Setup Autoloader Tune Search A ¢|* |

X TEMUs

File Mode Help

RF700 &[0 [inet

Options

i

T
Unload

‘ Dock | ‘ Undock | | O Turbo Auto OFf (default) I
— Cartridge ibo Always Un
I - — Control
(A \ Initialize ] |Lv3z:dr’:v--:y-:¥e| Vacuum D.<|
| [ nventoy |
I — Cassette Undock
= [ Leave cartridge on CompuStage
T
==
Fam
.
S
|

Temperature Control

— Statu
All Nitrogen Temperature

Suppress AutoFil for: [& 0@ min
— Dewar levels -
Autoloader 47%  4h30min ||| AutoFil starts in: 3h 30 min
Column B4%  8h40min

Reminder before filling starts: F B0 | min
=T —
Docker 837K  -1834°C
Holder 798K  -1934°C
Cassette gripper 852K  -1880°C
Cartridge gripper 833K -1838°C
Autoloader Dewar 786K  -1945°C
Column Dewar 787K -1945°C

Natural linear | HighC

MF X: Beam shift X ‘
L1: Alpha Wobbler
L2: Beam Blank =
L3: Spotsize - SA -
MF Y: Beam shift Y ~
R1: Screen lift
R2: Reset Defocus N
R3: Spotsize + a n'




Prep SerialEM

1. Load Settings file
1. Settings ->

SerialEMsetting_10cds

36kx_nP.txt

2. Load Navigator

1. Navigator -> Read &
Open -> nav.nav (in
your today folder)

3. When grid is loaded
and ready!!

1. “Open Valves” in

Microscope Control box
2. Putin 100um objective

aperture

VFriIeCamera Calibration Focus/Tune S Ipt Tasks Tilt Series Process N

_;‘ QBdn
|
=l 1 SerialEMsettings_8cds_36kx_nP.txt

- |

2 SerialEMsettings.txt
3 E\Backups\SerialEM_settings\SerialEMsettings_8cds_36kx_nP.txt
4 SCREENING_SEMsettings_20standard_36kx_nP.txt

Reload C:\Program Files\SerialEM\SerialEMsettings_8cds 36kx nP.txt 1

Save

Save As... ;| Ngvigator ‘ Window Help
Close ‘

Discard on Exit Read & Open.|

Read Defaults Merge File...

Autosave Save

Set a Property Save As...
Close

Montaging & Grids
Options

t to Marker
Align with Rotation...
New Map from Imag
Import Map...
Rotate May

1st for Backlas}
Backlash Settings...
Open Imaging St
Set Map Acquire State
Restore State
Acquire at Items...
End Acquire
List Files/Series/States
Delete Item
Realign to [tem

Force Center Align

[ \/J Try Scaling in Realign




Align grid (62x) to square (155kx

Double click on 155
Imaging state

Double click on atlas
in Navigator window

Left click on a
noticeable spot on
the grid atlas

4. Click “Add Marker”
Click “Go to Marker”

Imaging States

Add Current State | Add Nav ltem State ‘

Delete Name: ‘atlas -150C2

Set state: Imaging] MapAcquire‘ ]

Exp Bin Frame Name l‘
58x4.1 atlas - 150C2

Cam Mag Sp

99.3 1001 1

an P-4 4n4 7 AOAO  ATT e

1 155 8 645 1.001 1 5.8x4.1 200mesh - MMM
1 210 8 551 1.001 1 58x4.1 300mesh- MMM
1 280 8 543 1.001 1 58x4.1 400mesh- MMM
[ Navigator: nav_dummy.nav =0 X
Label: |1 [~ Registration point 1 i‘ = ﬁ
Color [Blue v| v Draw [ Rotatewhenload [ Foranchor state
#1 Note: |Sec 0 - LMM.st
[~ Acquire (A) [ Tiltseries [~ i
Set: \ \ \
Add Stage Pos | Registration 1 i’ Draw: [ Allreg. [~ None [ Labels
Add Points [ Collapse [ ShowAcquire [ Editmode [~
Add Polygon ‘ Label Color X G Z Type Reg. Acq. Note
i Blu -389 0.7 -19.6 Map 1 Sec0-LMM.st . B
B 389 0. q ec MM.st
Move Item 389 07 -0.0 Map1 Sec 2 - LMM.st =
-38.9 07 -0.0 Map 1 Sec 3 - LMM.st
Update Z
|_Pees | 6817 5815 -00 Pt 1
Go To XY -817.3 -353.7 -00 Pt 1
-740.7 -6405 -216 Pt 1
CONONZ 7965 -699.7 267 Pt 1
Go To Marker -7383 -7536 -268 Pt 1
-559.1 -574.7 -156 Pt 1
Load Map 1 Red -7435 -5238 -17.7 Pt 1
‘12 Red -6194 -5193 -154 Pt 1
i3 Red -684.1 -4628 -151 Pt 1
‘ } Red -622.3 -4012 -123 Pt 1
S} Red -689.8 -3478 -131 Pt 1
Delete ftem 16 Red -748.6 -2027 -145 Pt 1
: 17 Red -807.3 -3523 -183 Pt 1
Zeslgiolien 18 Red -8680 -297.9 -19.9 Pt 1
19 Red -813.3 -2364 -16.7 Pt 1
20 Red -7541 -1782 -141 Pt 1
21 Red -564.7 -4583 -126 Pt 1
22 Red -555.3 -9254 -310 Pt 1




Align grid (62x) to square (155kx

1. Tasks —> Eucentric-
Rough

2. Click “View” in
Camera

3. Find the spot in your
new image

ARG

Tilt Series  Process Navig p

Shift+| -
i
e
5LM

Set intensity.

Set Dose Rate
Shift+M
Shift+C
Shift+E 5

Setup Autocenter... | um

Move beam
Center Beam

Autocenter Beam

Eucentric - Rough ‘

Eucentric - Fine LQ

Eucentric - Both ‘,9

Refine & Realign

Set Tilt Axis Offset
Use Trial in LD Refine
Walk Up

Walkup & Anchor
Use View in LD

Set Increments

;J _QJ Camera &Beript L'

Setup View Focus Trial Record

|
Prevrewl Search ‘ ‘ ‘

=

meForCoff

-~ -~
PrepMMM ast-ISReco
v 5 2

Setup Cooker...

Cook Specimen
Assess Angle Range...
Assess Interset Shifts
Revise/Cancel Shifts
Reset IS & Realign
Set Iteration Limit
Use Trial in LD

Setup VPP Conditioning...
Setup Wait for Drift...
Reverse Tilt

Verbose

| Spedialized Options
[ wawuinemmny

Test-ISRecord |




Align grid (62x) to square (155kx

s ’N?‘{iggtm ] Window Help

1. Leftclick on the same

spot in your new image

Close

2. Navigator -> Shift to
Marker

ndo Transformatio

Change Registration

shift to Marker

Undo Last Shift

3. Select atlas in Navigator

New Map from Image

window and click o
“Update Z2”

Backlash Settings...
Open Imaging State

Set Map Acquire State

Restore State

4 . Re p e at O n a feW d iffe re nt /\(‘qu‘im at Items...
spots to make sure these
a re nOW a I Igned Delete Item

Realign to Item

Force Center Align

‘ \/‘ Try Scaling in Realign

m Navigator: nav_dummy.nav
Label: ’17 [ Registration point 1 é‘ [ ﬂ
Color |Blue v| ¥ Draw [ Rotatewhenload [ Foranchor state

#1 Note: [Sec 0 - LMM.st

[~ Acquire (A) [ Tiltseries [~ =

Set: | | |

Add Stage Pos | Registration 1 ﬂ Draw: [ Allreg. [~ None [ Labels
Add Points [~ Collapse [~ ShowAcquire [~ Editmode [~

Add Polygon ‘ Label Color X e Z Type Rig. Acg. Note
‘ 1 Blu -389 0.7 -19.6 Map 1 Sec0
Bo—=36¢ 0-F—=0-0—vtapt Sec-+=tivitst
3 Blu -389 07 -0.0 Map1 Sec2-LMM.st
4 Blu -389 07 -0.0 Map1 Sec 3 - LMM.st
5 Red -681.7 -5815 -0.0 1
6 Red -817.3 -3537 -0.0
7 Red -740.7 -6405 -216
Gy vz | g Red -7965 -699.7 -26.7
r Corker 9 Red -738.3 -7536 -26.8
= 10 Red -559.1 -574.7 -156
Log P 11 Red -7435 -5238 -17.7

! 12 Red -6194 -519.3 -154
13 Red -684.1 -462.8 -15.1
14 Red -6223 -401.2 -12.3

15 Red -689.8 -347.8 -13.1

7RIV

Delete Item 16 Red -7486 -2027 -14.5

= 17 Red -807.3 -3523 -183
Realgntottem | |12 Red -8680 -2079 -199
19 Red -813.3 -2364 -16.7

20 Red -754.1 -1782 -14.1

21 Red -5647 -4583 -126

22 Red -555.3 -9254 -31.0

= EENns BRcata Dias




Collect square maps

1. Open up atlas of interest - -
by double Clicking on Labet [ Regisaonpomt 12] - 2]

Color [ e v| v Draw [ Rotatewhenload [ Foranchor state

item in Navigator window | .. 2 s

[~ Acquire (A) | Tiltseries  [= [
2. Click “Add points” e
* I C p O I n S Add Stage Pos | Registratiol J‘ Draw: [~ Allreg. [~ None [ Labels

. R . [“Show Acquire [ Editmode [
Add Polygon ‘ abel Color X Y4 Z Type Reg. Acq. Note
3. Left click to add pointsin / ST

1 A~
—— L=1l*) :JG:U U:f :U:U viap : V ;
squares that you wantto | o @ = o oo =i
—_ 5 Red -681.7 -5815 -00 Pt 1
collect maps of =0 A F
_GoToxvz | g Red -7965 -609.7 -267 Pt 1
Go To Marker 9 Red -7383 -7536 -26.8 Pt 1
o )) W 10 Red -559.1 -574.7 -156 Pt 1
4. Check “Collapse group B =
.
SO yOU cah see how many A e B e
) : . =
Realign to ltem : 7 : ; 3
you're selecting S
20 Red -754.1 -1782 -141 Pt 1
21 Red -564.7 -4583 -126 Pt 1
1

5. Check “Acquire” to add A 2 e
next to all of these points




Collect square maps

1. File -> New Montage -
> correct settings ->

save in “setup” folder Mgés/ /j

Save non-float data as

Magnification: 155 =
C Bytes @

as MMM .st
Number of pieces in X: |1 i‘ Y: |1 é‘ ! )
IS

@)

Piece size in X: ’5760 Y ’4092
| | 0.2 2 |
Overlap in X: ‘576 Y: ‘576 Reset :
g Save in extended header
Minimum overlap: 10% il and [0-5 micron = 5 T|Itan9|e
% ] [ Intensity
Total Area: 5760 x 4092 pixels pt I Stage position
. Update bp .
901.0 x 640.1 microns v Magnification
5 o E [v" Exposure dose
Iv' Move stage instead of shifting image

[~ Skip pieces outside Navigatoritem [0 Mamuminumb oS ection= 1360

(Be generous)

r [+ Save extra information in a '.mdoc' metadata file
[~ Ask about making map after each montage Save images to

- ®©
[~ Use Montage Mapping, not Record parameters e MRC stack fle

=

[0 " Series of TIFF files listed in an Autodoc file
= )
H {0.5
v @® © © ©

[ Use settings for high-quality stage montage [+ Skip this dialog in future (re-enable in File menu)

oK Cancel ‘ lJ oK Cancel | 2l




Collect square maps

MapGrids
PrepMMM

TimeForCoffee |

AcquireHolesCTEM |

1. Check the Pre P MMM Acquire-OHolesCTEM-IS|

autorun |

script (ctrl+left click OyceTargeDeonis

CenterBeam

to open) —

|

|

|
WaitForRefiling |
Test-ISRecord |
|

|

|

|

Script 2: PrepMMM E

ﬂEditor il MScript Down IS-Pixel

EmailTest

Tabor ° to complete command
—» |MacroName PrepMMM A

TestBTID
MapToJPG

# Select square targets, setup 1x1 montage at square imaging state

— » |Eucentricity 1

necessary = » ypdateltemz
_>
_>

#Acquire montage

M

#Make the current image or montage a new Navigator map
Newmap

ErrorBoxSendEmail Script Stopped!

Add TiltTo ## if you are collecting at tilt




Collect square maps

1. Navigator -> Save

2. Navigator -> Acquire
at items

1. Choose PrepMMM
next to “Run script”

2. Check “Close column
valves” if you’re going
to leave the room

{N,ngft,(,)',,] Window Help

Read & Open...

Merge File

Save

Save As...
Close
Montaging & Grids
Options
insform Iltems
Jndo Transformatior
Change Registration
ft to Marker
Jndo Last Shift
Align with Rotation...
New Map from Imag
Import Map...
Rotate Map
Adjust for Backlast
Backlash Settings...
Open Imaging State
Set Map Acquire State
Restore State

Acquire at Items...

End Acquire

List Files/Sefesp btes
Delete Item

Realign to [ter

Force Center Align

L\/J Try Scaling in Realign

Acquire at ltems

Initial Actions aﬁeﬁé\/loving Stage
[ Rough eucentricity

|~ Autocenter beam

[ Realign to item

[ Cook specimen

[ Fine eucentricity

[~ Autofocus [

. | Run script 1MapGrids

Primary Task
" Acquire map image or montage

¢ Just acquir i
@ Run script | [PrepMMM ~]

c

[~ Run script after: |MapGrids

[ Do subset from index | toPSO

| Skip initial stage move to item
[~ Skip Z moves in initial move and Raalign
[ [6 5 ate after alianing

| Close column valves at end

| Send email at end

Postpone Cancel ’—sz




igator Window Help

;‘ E‘ Low Dose Control LI
[~ Low Dose Mode

Al I8N Sguare an d hole .., “glamme

@ () ©

=

I S

1. Check “Low Dose” in HEE
LowDose Ea e N

2. Goto:Recin LowDose JMQ

[v" Normalize beam through View

3. Goto:View in LowDose Rt s

(K Navigator: 4] J 4] J J
1. Make sure that defocus on [=1 = “wwee 20 |
o =
. . . Color |Blue v| ¥ Draw [ Rotatewhenload [ Fora
microscope is -80, if not R
h d f 80 . h [~ Agawissid) [ Tiltseries [~ =
change defocus to -80 with |« =7 \
h a n d a n e I 4 . "ﬂ Registration 1i‘ Draw: [ Allreg. [ None [ Labels
p X d Pg J [~ Collapse [ ShowAcquire [ Editmode [~
| Label Color X Y  Z Type Reg. Acq. Note
. X X 1 Sec 0- LMM.st
| 2 Bu -389 07 -00 Map1 Sec1-LMM.st
. Move Item 3 Blu -389 07 -00 Map1 Sec2-LMM.st =
4 Bu -389 07 -00 Map1 Sec3-LMM.st
. ° . [SiUpdaie 210} = Red -681.7 -5815 -00 Pt 1
in the Navigator window -
7 Red -740.7 -640.5 -216 Pt 1
crieiz 8 Red -7965 -699.7 -267 Pt 1
Go To Marker 9 Red -738.3 -7536 -268 Pt 1
- 10 Red -550.1 -574.7 -156 Pt 1
Load Map 4 Red -7435 -5238 -17.7 Pt 1
eft click on a featureon | = 7 =an
. > | i3 Red -684.1 -4628 -15.1 Pt 1
14 Red -6223 -4012 -123 Pt 1
15 Red -689.8 -347.8 -13.1 Pt 1
Delete item 16 Red -7486 -2927 -145 Pt 1
: 17 Red -807.3 -352.3 -183 Pt 1
Reslgntottem | [y Red -8680 -207.9 -19.9 Pt 1
19 Red -813.3 -2364 -167 Pt 1
. )) J) 20 Red -754.1 -1782 -14.1 Pt 1
21 Red -564.7 -4583 -126 Pt 1
. 22 Red -5553 -9254 -31.0 Pt 1
23 Red -4917 -980.8 -27.7 Pt 1
24 Red -4356 -919.7 -236 Pt 1
25 Red -4955 -8638 -27.7 Pt 1
. 124 124 26 Ret—S72 505224 8Pt
IC 0 O 27 Blu -7407 -6406 -216 Map 1 Sec 0- MMM.st
L ] BIU-780.5"-700.T-26.7"Map T eC T - MUVM.ST
29 Blu -7382 -754.0 -26.8 Map 1 Sec2- MMM.st
30 Blu -550.0 -574.3 -156 Map 1 Sec3- MMM.st
31 Blu -7435 -5236 -17.7 Map 1 Sec4 - MMM.st
32 Blu -619.3 -519.0 -154 Map 1 Sec5 - MMM.st
33 Blu -684.0 -4624 -15.1 Map 1 Sec 6 - MMM.st
34 Blu -622.3 -400.7 -12.3 Map 1 Sec7 - MMM.st
35 Blu -689.7 -347.3 -13.1 Map1 Sec8 - MMM.st
36 Blu -7486 -2023 -145 Map 1 Sec9 - MMM.st ~




Align square and hole

1. Click "View” in Camera

‘ NTV o
° - - L
window o
;I Ej Camera&Beript LI Read & Open...

2. Find the feature in your | e
neW Im age Preview‘ ASearch ‘ - 1 A‘ ir::@As
1. If it’s not there then Shift + ||zt romnis] monef Wit
right click and drag the “
|ma_%e, to move the stage
until you can see it e
3. Leftclick on the same
spot In your new image NN T

4. Navigator -> Shift to it
Marker

1ging Sta

Import Map...
Rotate Map

Set Map Acquire State

5. Repeat on a few different

Acquire at Items...

spots to make sure these sl
a re n OW a I Ig n ed List Files/Series/States

Delete Item
Realign to Item

Force Center Align

»/5 Try Scaling in Realign




Make P template

1. Shift + right click and Q00000
Nt you are contered
gver%/he center of your . ‘109 .
Lo Cemersdsne e, |@ 0o
2. Centered in the middle of
urholestorazaori (@) @) @ @ @ @

pattern
four holes for a 2x2 or 4x4

2. Click”View” in Camera a
few times to make sure
your stage isn’t drifting
away from this position




Make a P template

1.

2.

Click ”Setup” in the
Camera box

Select View and set

parameters

1. Bin=38, Areasize =
encompass P template,
Exposure = 2s

Click "View” in Camera
and you should see just
the template you want
very centered

Click “P” in Buffer Controls
’Ic)o save the image in buffer

Col

Parameterse
- Search Focus Trial Record Preview Mont-map
Camera & Script ?
1 Positioning
Parameters for \/jew
i : Acquisition Bi Top|0
Setud View | Focus Trial Record > ’""‘"g P

ntinuous
® Single Image

P ew Search ‘ ‘ Processing

-| D! Script l]

Trial

View Focus Record

L al -
MapGrids £repMMM meForCoffi
| X

Uni

-~ -~ -~ G
fepends PrepMMM meForCoff ¢ e
G i b &
Binned size: 720 x 510
5 Swap X &Y
Exposurs time 0.67x0.47 um @ 0.925 nm P ‘

gy settig) 0.0000  sec

correl

normalized
in Normalized

fll  Dose: Not calibrated
Operating mode

Linear
@ Counting

lated double sampling (CDS) Anti-aliasing 4

OK

Camera Parameters -- K3

o> o b w0

Left |0
Bottom 4092
Right [5760
’ -

L
:

Recenter !

Area size

)@ 0.0007 if ot 0.0 Hait Full ‘

Shutter mode
@ Beam blanking only

Wide] Juarter Wide Half ‘

10%Less |  10% More ]
Update Dose rate: Not califfg) Jd F

Dose Fractionation mode

o |

Acquire Cancel

= Buffer Controls

Copy Active Image to Buffer

Al 8| c] o]

P New]

‘TO(;'

Memory = 0'VIB

[ Align to B instead of O
Read into Buffer O i‘

[~ Protect unsaved Record images

?

3

‘ v




Make a P template

1. Click “Setup” in

Camera again

2. Select "View” at the

top and set

1. Bin =8, Area size =
full, Exposure = 0.2s

Camera & Script

Setud View‘ Focus

]

Trial Record

Pr ﬂ Search ‘

-~ -~ -~
fepends PrepMMM meForCoff
G i b &

“amera Parameters -- K3

Focus € Trial Record Preview Mont-map
Parameters for \/j@w eeoong
Acquisition Binning Top 0
Continuous 05
@ Single Image . Left 0
Processin 2
4 9 3 Bottom 4092
4
U lized 3
» nnormalizt 5 Right (5760
I @ Gain Normalized ~
S -
i =1 1] ¥]
L
Recenter ‘
X Binned size: 720 x 510 Swap X &Y ‘
Equetaie 0.67x0.47 um @ 0.925 nm 2
Setts 0.0000 sec Area size
A0 20.0007 if not 0.0 Quarter ralr Full
Shutter mod
kbt Wide Quarter wide Half |

@ Beam blanking only

10% Less 10% More Square ‘

1| Dose: Not calibrated

Update 1 Dose rate: Not calibrated
) Qperanng mece I~ Dose Fractionation mode r
Linear 004
@ Counting ki ‘
Use correlated double sampling (CDS) Anti-aliasing

OK Acquire Cancel ? ‘




example of 3x3

Make image shift template
o0

1. Click “Add Points”
and left click the
inner edge of the four

corner holes of your X

by X pattern C W

2. Click ”Stop Adding” : —

Label: 1 [~ Registration point 1 j‘ [~ Corner point (C) ﬂ

v Draw [ Rotate whenload [ Foranchor state

0 - LMM.st
itseries [~ New file atitem [~ New file at group

g State ‘ TS Params ‘ Filename | Focus Pos |

On flat grid, go with 5x5 unless you have a lot of
empty/dirty holes that you’re going to have to

Registration 1 i‘ Draw: [~ Allreg. [~ None [ Labels
[~ Collapse [~ Show Acquire [~ Editmode [ EditFocus

Add P Label Color X e Z Type Reg. Acqg. Note
delete _ AddMarker | [ Blu -389 0.7 -19.6 Map1 Sec 0 - LMM.st ~
— P Blu -389 07 -00 Map1 Sec1-LMM.st
Move item 3 Blu -389 07 -00 Map1 Sec 2-LMM.st =
4 Blu -389 07 -00 Map1 Sec3-LMM.st
& 5 Red -6817 -5815 -00 Pt 1
Go To XY 6 Red -817.3 -3537 -00 Pt 1
7 Red -740.7 -6405 -216 Pt 1
_GoToxvz | g Red -7965 -699.7 -267 Pt 1
oo Narker 9 Red -7383 -7536 -268 Pt 1
e 10 Red -559.1 -5747 -156 Pt 1
Load Map 1 Red -7435 -5238 -17.7 Pt 1
T 12 Red -6194 -5193 -154 Pt 1
_ NewMap | |3 Red -684.1 -4628 -151 Pt 1
Anchor Map 14 Red -6223 -401.2 -123 Pt 1
15 Red -689.8 -3478 -131 Pt 1
Delete Item 16 Red -7486 -2027 -145 Pt 1
: 17 Red -807.3 -3523 -183 Pt 1
Reslgntottem | {12 Red -8680 -207.9 -19.9 Pt 1




ake image shift template

Click “Setup” in
Camera again

Select “"Record” at the

top and set

1. Bin=1, Area size =
full, Exposure = 0.5s,
no dose fractionation

Camera & Script

Setud View‘ Focus

2]

Trial ‘ Record

Pr ﬂ Search ‘ ‘

-~ -~
fepends PrepMMM meForCoff
G i

=

Senaitv
Camera P: - K3
Parameter set
" Search C View " Focus C Trial ecord | C Preview  Mont-map
parametersfor Record P°5m°“"19
Acquisition Binning Top [0
Continuous
@ Single Image Left |0
Processing o5 Botom 092
4
Unnormalized g Right 5760
@ Gain Normalized
Y -
8 = 4|
Recenter
Binned size: 5760 x 4092 SwapXaY
Exposurs ine 0.67x0.47 um @ 0.116 om P
09 Jsettdf ] 0.0000  sec Area size
NEAEEIM 0.0007 if not 0.0 Quarter Half E

Shutter mode

@ Beam blanking only Wide Quarter ‘ Wide Half

10% Less 10% More Square

Dose: Not calibrated

Update Dose rate: Not calibrated
CEIEITYIEES [ Dose Fractionation mode
Linear 04
@ Counting .

Use correlated double sampling (CDS) Anti-aliasing 4

—— conee !

N




1.

Select the first corner
point you added in
the Navigator window
(left click on the
correct number)

Click ”"Rec” in the Low
Dose window

Navigator ->
Montaging and Grids
-> Set Multi-shot
Parameters

ss Window

Open
Read & Open...
Merge File...

Save
Save As...

Close

‘ Montaging & Grids
Options t%

Transform ltems
Undo Transformation
Change Registration
Shift to Marker

Undo Last Shift

Align with Rotation...
New Map from Image
Import Map...

Rotate Map

Adjust for Backlash
Backlash Settings...

Open Imaging States ..

Set Map Acquire State
Restore State
iAcquire at tems...

End Acquire

List Files/Series/States
Delete Item

Realign to Item

Force Center Align

| Try Scaling in Realign

| Find Holes in Regular Grid...
| Add Grid of Points
|Add Grid Like Last One

- igator Window Help

[=][D] Low Dose Control 2]
[~ Low Dose Mode

[~ Continuous update (see tooltip)
Define position of area
@ (9 @)

’_
Goto:‘l—‘* 4'

Additional beam shift
[ set  Reset|
— Offsets for: ® View (" Search

Defocus: -60- Shift Zero |

= oppons Blank

[~ BLANK BEAM when screen down

¥ Normalize beam through View

[~ Keep Focus and Trial identical
Copy current area settings to

Dvi| [Ef fm] R ST

Setup Super Montage |

| Setup Corner Montage
Setup Polygon Montage
Setup Full Montage

Set Grid Limits

Polygon Super Montage -69

Divide Points into Groups

Set Group Radius.

Set Multi-shot Parameters...

Combine Points for Multi-shots...
Show Shots when Show Acquire
Show Whole Area for All Poir

Add Circle Polygon

Polygon from Corners




I\/Iake iImage shift template

w

Check settings in multi-shot
panel

Click “For Corners..” to start
Click “IS to Navigator Pt”

Click “Record” in Camera

and make sure you don’t

see any carbon in your

image

1. If there is carbon right click
and drag (no shift key!!) the
nnageLnncherelsnone

click "Record” again to
check

Click “Save Image Shift”

Iterate #3-5 for all four
corners — the program will
grey out the buttons
automatically when you're
finished

Click "OK”

% Multiple Record Setup

Y
[ Do multiple Records within each hole

Regular patter of holes: = X _:_i by X ::J

[ Omit comners of 3 by 3 array (cross pattern)

[ Use custom pattern (9 positions def
Save Image Shift Values at Holes

Iv Do Records inmultiple holes
Multiplier of usual delay, after shiftingzto hole: E

Spacing: 2.07 and 2.19 um Angle to stage X: 180.6 deg

‘ For Corners of Regular Pattern ’ et Stom Pattern i

[ 5 toNav o] save mage shi | |

[
|
[

I/ Image shift should be measured neal Saus
) -

[~ Save Record image
Early Returns for K2/K3

@ Full sum

" Early ret
F y - | D camera & Seript

Setup View Focus

7]

Trial

Record

Extra delay after Preview Search

[v" Adjust beam

-~ Fs -~
MapGrids = PrepMMM = meForCoffi =

Cancel

Bl e o s

2|




Make image shift template

1. Click “Reset Image
Shift” in

2. Click “View” in
Camera and you
should be hovering
near your last corner
point

Alignto O | To Marjer

;| El Image Alignment & Focus

Clear

7]

Reset Image Shift ‘ Autofocus

[v' Correct backlash in stage

[ Adjustimage shift between
[v' Trim dark borders in Autoa

Set Autoalign Trim Fra

[~ Center image shift on tilt ax

- | Options Def. target = -1.00 um
Iv' Move stage for big mouse shifts
Set Threshold Shift |

;, 3’ Camera & Scri Ll
Setup View Trial Record

Preview

Search

MapGrids

-~ -~ -~
PrepMMM meForCoff
v v v

= View near “#26



Correct astigmatism and coma

easure Defocus

s |
|Move Focus Ce

| Check Autofo

1. Center yourself on carbon
(shift+right click)

2. Focus/Tune -> Set Target (-0.3)
3. Focus/Tune -> Autofocus

1’Report Shift & Drift
Report on Existing o

Show Existing Corr

4. FOCUS/TU nhe -> Correct | Show Image Stretch ‘ ¢
astigmatism by ctf 2
1.  Run again if change is >0.001 in i
Set Thresho

log

5. Focus/Tune -> Coma-free
alignment by ctf

1. Runagain if change is >0.2 in

Set Tilt Direction
|Set Min Binning
Test Filter Cutoffs
Drift Protection

| Set Absolute Limits

|Og Use Absolute Limits

Limit Offset Defocus
>
. _> : | Correct Astigmatism by CTF | ]
6 E(S)'lﬁ u ?r]/-g'LtjirS] re]'] b Cgtr_'fre Ct ‘ | Coma-free Alignment by CTF | 4—
g y |Set CTF Acquire Params f_ff
1.  Run again if change is >0.0005 L d
|n Iog Beam-tilted FFT Array i
Correct Astigmatism by BTID I
|Set BTID Astig Beam Tilt L—
llg)vldv(;oma—free Alignment | » —f-‘
W Resgt Defocus i
il 1‘Verbc‘)g‘e n i




;,ElCame& _|

Prepare for collection || =1
Mped\jppMMMHmmj

1. Click “View”
Camera and center
yourself over a hole

2. Select “Define
position of area:
Focus” in Low Dose

3. Left click to drop

— Offsets for: ® View ( Search —

focus position el s
(yellow) onto carbon Y =

[~ BLANK BEAM when screen down
n eXt to t h e h O | e v Normalize beam through View

[~ Keep Focus and Trial identical
Copy current area settings to

_l_l_l_l_l
enter Unshitted | _ Balance Shifts_|

v Rotate inter-area axis -43 deg

;I il Low Dose Control LI
~ | | LowDose Mode

[~ Continuous update (see tooltip)
Define pos
@ None

Position on tilt axis:




Prepare for collection

1. Click “Setup” in Camera
and set parameters

1.

2.

View: bin = 8, area size =
P template exposure =
0.2s

Focus: bin = 2, area size
= sguare, exposure =
0.2-0.5s

Record: bin =1, area
size = full, exposure = 6s
dose fractionation ON —
frame time: 0.06s Set
File Options:
(YYYYMMDD _username
_sample_grid), Set
Folder (X:/SEM_frames)

Camera Parameters -- K3
Parameter
"~ Search ~ Focus € Trial " Record ¢ Preview C Mont-map
Parameters for \/jew L
Acquisition Binning Top 0
Continuous 05
¢ Single Image 1 Left 0
Processin: 2 [
9 2 Bottom 14092
V] lized ~
nﬁorma iz : - Right 5760
® Gain Normalized
6 -
| m 4
v J
| [« 8]
Recenter
) . Binned size: 720 x 510 Swap X &Y
ST I 0.67x 0.47 um @ 0.925 nm £
it cattinn 100000 sec Area size
Camera Parameters -- K3 £ not 0.0 Half Full
Parameter set
" Search View |® Focus| ¢ Trial " Record Preview © Mont-map Wide Quarter | Wide Hatf
Parameters for FOCUS ECskomg 10% Less 10% More
Acquisition Top 0 :
Continuous
@ Single Image Left (834
Processing Bottom 4092
Unnormalized Right 4926 Camera Parameters -- K3
@ Gain Normalized
- AL View Focus Trial Preview Mont-map
v
Positionin,
o Record L
Bcenier Binnin Top |0
W Binned size: 2048 x 2046 Swan X8 Y ”
EXpostielie ° 0.47 x 0.47 um @ 0.231 nm g Letl0
0 = Area size
Drift setting (0.0000  sec 2
’ a Half Full o 5
Minimum 0.0007 if not 0.0 uarter a u | 4
ight 15760
Shutter mode X , 5 Right
s . Wide Quarter Wide Half zed
@ Beam blanking only 6 a
8 = Kl
10% Less 10% More
. Recenter
Binned size: 5760 x 4092 Swap X &Y
Ciposize ine 0.67x0.47 um @ 0.116 nm E ‘
Drift settiing [0.0000  sec e
Minimum 0.0007 if not 0.0 Quarter Haif
Shutter mode Wide Quart Wide Half
@ Beam blanking only de fuarer st
10% Less 10% More Square
osoEoLcalated Update Dose rate: Not calibrated
Operating mode ¥ Dose Fractionation mode
Linear
Use correlated double sampling (CDS) Anti g

settp|
d

Acquire Cancel




Pick points to start collecting

1.

Double click on the
square you want to start
with (go in order to make
it easier for yourself)

Check "Collapse groups”

Click "Add Polygon” and
outline the area you want
to image

Click “Stop Adding”

Click “Add Points” and
click in the center of 5

holes to tell the program
spacing

Click “Stop Adding”

Like this :

Near the middle of the square

L] Navigator: nav_dummy.nav

Label: |1 [ Registration point 1 é‘ [N ﬂ

OO000O
O00®
O00O®
O®®®

Color [Blue ~| v Draw [ Rotatewhenload [~ Foranchor state
#1 Note: ‘Sec 0-LMM.st
[ Acquire (A) [ Tiltseries -

Set: File Props | Imaging State | Jorams | | Filename |
[v Labels

Add Stage Pos | Registration = Pyaw: [ Alireg. [ None
Add Points ‘ [~ Collapse | [~ ShowAcquire [~ Editmode [~

Add Polygon J Label Color X Y Z Type Reg. Acq. Note

1 Blu -389 07 -196 Map1 Sec 0 - LMM.st
- |2 Bu -389 07 -00 Map1 Sec 1-LMM.st
Move Item 3 Blu -389 07 -0.0 Map1 Sec 2 - LMM.st
4 Bu -389 07 -00 Map1 Sec3-LMM.st
% 5 Red -6817 -5815 -00 Pt 1
Go To XY 6 Red -817.3 -3537 -00 Pt 1
7 Red -740.7 -6405 -21.6 Pt 1
_GoToxvz | g Red -7965 -699.7 267 Pt 1
oo 9 Red -7383 -7536 -268 Pt 1
—_— |10 Red -550.1 -5747 -156 Pt 1
Load Map 1 Red -7435 -5238 -17.7 Pt 1
12 Red -619.4 -519.3 -154 Pt 1
_ NewMap | |3 Red -684.1 -462.8 -151 Pt 1
14 Red -6223 -4012 -123 Pt 1
15 Red -689.8 -347.8 -13.1 Pt 1
Delete ltem 16 Red -7486 -2027 -145 Pt 1
- 17 Red -807.3 -3523 -183 Pt 1
[Resbgniotem| |2 Red -8680 -297.9 -199 Pt 1
19 Red -8133 -2364 -167 Pt 1
20 Red -7541 -1782 -141 Pt 1
21 Red -564.7 -4583 -126 Pt 1
22 Red -5553 -9254 -31.0 Pt 1
23 Red -4917 -980.8 -27.7 Pt 1
24 Red -4356 -919.7 -236 Pt 1
25 Red -4955 -8638 -27.7 Pt 1
26. Roded 37 805.2. 24.0..Pt. 1
27 Blu -740.7 -640.6 -21.6 Map 1 Sec 0 - MMM st
78 B0 -/965 -700.T -26.7 Wap 1 T 5
29 Blu -7382 -7540 -26.8 Map 1 Sec2- MMM st
30 Blu -550.0 -574.3 -156 Map 1 Sec 3- MMM st
31 Blu -7435 -5236 -17.7 Map 1 Sec 4 - MMM st
32 Blu -619.3 -519.0 -154 Map 1 Sec 5 - MMM st
33 Blu -6840 -4624 -151 Map 1 Sec 6- MMM st
34 Blu -6223 -400.7 -123 Map 1 Sec 7- MMM st
35 Blu -689.7 -347.3 -13.1 Map 1 Sec 8- MMM st
36 Blu -7486 -2923 -145 Map 1 Sec 9 - MMM st




Pick points to start collecting

1. Navigator -> Montaging

& Grids -> Add Grid of
Points

1. Enter polygon number
2. Away from focus area
3. Turn acquire on at all

points

Check “Edit Mode” on
Navigator window and
delete any bad holes

1. Left click on pt to
remove and backspace

Open
Read & Open...
Merge File...

Save

Save As...

il ontagin% Setup Corner Montage
Options Y » Setup Polygon Montage
Transform ltems Setup Full Montage
Undo Transformation Set Grid Limits
Change Registration Setup Super Montage
Shift to Marker | Polygon Super Montage,

Undo Last Shift
Align with Rotation...

New Map from Image Like Last One

Import Map... | Divide Points into Groups
Rotate Map ; Set Group Radius

Adjust for Backlash ‘ Set Multi-shot Parameters...
Backlash Settings... Combine Points for Multi-shots...

Open Imaging States ... Show Shots when Show Acquire
‘ Show Whole Area for All Points

Iset Map Acquire State

Restore State | |Add Gircle Polygon

Label: |1 [ Registration point 1 é‘ [N

LK Navigator: nav_dummy.nav

2]

Color |Blue v| ¥ Draw [ Rotatewhenload [ Foranchor state
#1 Note: ISec 0-LMM.st

[” Acquire (A) [ Tiltseries [~ i

Set: ‘ | |

Add Stage Pos | Registration 1 é‘ Draw: [~ Allreg. [~ None [ Labels

Add Points [~ Collapse [~ Show Acquire

Add Polygon Label Color X Y

Blu

—— Blu -389
Move Item

1

2

3 Blu -389 ¥

4 Blu -389 0.7 -0.0 Map1
% 5 Red -681.7 -5815 -00 Pt 1

6

7

8

9

Go ToXY Red -817.3 -3537 -0.0
Red -740.7 -6405 -216

__GoToXvz | Red -7965 -699.7 -26.7
Go To Marker Red -7383 -7536 -26.8
3 Red -550.1 5747 -156
Load Map 1 Red -7435 -523.8 -17.7

12 Red -619.4 -519.3 -154

_ NewMap | 13 Red -684.1 -462.8 -15.1
14 Red -6223 -4012 -123

15 Red -6890.8 -347.8 -13.1

Delete tem 16 Red -7486 -2027 -145

= 17 Red -807.3 -3523 -18.3
Resliontoftom 18 Red -868.0 -207.9 -199

JIJIJIVDIIVIVI TV

0 - LMM st
Sec1-LMM.st
Sag 2 - LMM.st
el 3-LMM.st



Pick points to start collecting

1. Navigator ->
Montaging & Grids ->
Combine Points for
Multi-Shot

1. Insame group as
current point

2. Click “Combine
Points”

2. Navigator -> Save

3. Settings -> Save

Ty i Retion

Read & Open.,
M ile.

ave As.

Close

o =
Options T

Transform ltems

Undo Transformation
Change Registration
Shift to Marker

Undo Last Shift

Align with Rotation...
New Map from Image
Import Map...

Rotate Map

Adjust for Backlash
Backlash Settings...
Open Imaging States ...
‘Set Map Acquire State
Restore State

Acquire at Items...
End Acquire
List Files/Series/States
Delete Item
Realign to ltem

Force Center Align

Setup Corner Montage
Setup Polygon Montage
Setup Full Montage

Set Grid Limits

Setup Super Montage
Polygon Super Montage

Find Holes in Regular Grid...

Add Grid of Points

Add Grid Like Last One
Divide Points into Groups
Set Group Radius

Set Multi-shot Parameters...

I Combine Points for Multi-shots... I

Show Shots when Show Acquire
Show Whole Area for All Points

Add Circle Polygon

Polygon from Corners

File | Settinas | Camera Calibration Focus/Tune Script Tasks Tilt Series
_:_S; opan...

1 SerialEMsettings_8cds_36kx_nP.txt

2 SerialEMsettings.txt

3 E\Backups\SerialEM_settings\SerialEMsettings_8cds_36kx nP.txt
4 SCREENING_SEMsettings_20standard _36kx_nP.txt

a |
v |

Siz¢

Save As

Close

Multiple Hole Combiner

Combine points marked as Acquire

On image in current buffef
Inside current polygon

r @ |n same group as current point

Combine Points ?

Display mutti-shothaefore combine

Reload C:\Program Files\SerialEM\SerialEMsettings_8cds_36kx nP.txt

Process

Discard oy ¥it

Read“sesedits

Autosave

Set a Property

1= .



Script 5: Acquire-9HolesCTEM-IS
<- |Editor -> Up | Script  Down

Tabor * to complete command

MacroName Acquire-9HolesCTEM-IS A

[
# Acquire-9HolesCTEM-IS - Acquire a set of images using image shift (for small holes 1.2-°
# Define group pattern in “Multiple Record”

TD_low=-0.8
TD_high =-2.2

el A,
aena=-o-T

bigstep = $TD_low - § h

AreDewarsFilling
1. Check the Acq-
Delay 60 sec
# UpdateHWDarkRef 0

9Holes...IS script and

loop 15

adjust the defocus i i

break

} {NTVI(J()T()IJ Window Help

Read & Open...

i Merge File...
elseif $reportedvaluel ==

range as desired

Acquire at [tems

Save
Save As... Initial Actions afte*\fi\/loving Stage
Close [ Rough eucentricity

Montaging & Grids [~ Autocenter beam

1. -1.0and-2.0 common,
can lower for higher <
resolution or raise for i s
harder to see particles

Options [ Realign to item

[~ Cook specimen

[ Fine eucentricity

Change Registration [~ Autofocus [

shift to Marke
ndo Last Shift

[~ Run script ﬁMapGrids

tS -
Align with Rotation... rimary Task

" Acquire map image or montage

€ Just acqui i
e
@ Run script| AcgHoles-9HolesCTEM-IS :

(

New Map from In

Import Map...

2. Navigator -> Acquire at
ltems

1. Run script: AcqHoles-
9HolesCTEM-IS

Rotate Map

djust tor Backlast

Backlash Settings, [ Run script after: Wég;e‘u_ds

Open Imaging Sta

Set Map Acquire S

Restore State [ Do subset from index \l‘ tOPBO

Acquire at Items..

End Acquire

[ Skip initial stage move to item
[ Skip Z moves in initial move and Realign
>

List Files/Series/States

I Close column valves at end

Delete Item

| ‘ I Send email at end
|

Realign to Item

\ |
Cancel | -_;J

Force Center Align

Postpone '

[ \/‘ Try Scaling in Realign



Start data transfer to WARP

1. Double click on
“transfer_serialEM.bat”
1. Enter username

2. Enter session name
(from Leginon screening
— 21sepl4f)




Move to DUMMY and pick

remaining points

1. Open DUMMY
serialEM

2. Settings -> settingsfile

1. Most likely:

SerialEMsettings _10c

ds_36kx_nP.txt

3. Navigator -> Read &
Open -> nav.nav

4. Navigator -> Save As
> nav_d.nav

AR TIyHm
i | Navigator | Window  Hel

Jpen
Read & Open...
Merge File...

Save

Save As...

SerialEM Close

Montaging

Options
Transform Items
Undo Transformation
Change Registration
Shift to Marker
Undo Last Shift
Align with Rotation...

1 SerialEMsettings_8cds_36kx_nP.txt
Size¢ 2 SerialEMsettings.txt

l 3 E\Backups\SerialEM_settings\SerialE s 8cds_36K]
4 SCREENING_SEMsettings_20standard _. ChPExt

New Map from Image

Import Map...
Rotate Map
Adjust for Backlash

Reload C:\Program Files\SerialEM\SerialEMsettings_8cds 3

T Backlash Settings...
Save

Open Imaging States ...

Save As...

Set Map Acquire State

Close
Discard on Exit
Read Defaults

Autosave

| Restore State

|
| Acquire at Items...

End Acquire
} List Files/Series/States

Set a Property |
[ Delete Item

Realign to Item

Force Center Align

Try Scaling in Realign



Move to DUMMY and pi

LK Navigator: nav_dummy.nav Hﬂn

[ ] [ ] [ ]
I e I | l a | I I I I I O I I I l Q Label: |1 [ Registration point 1i‘ [ ﬂ
S Color |Blue ~| v Draw [ Rotate when load

[~ For anchor state

#1 Note: ‘Sec 0-LMM.st

I [~ Acquire (A) |~ Tiltseries [ =

1. Pick points the same way Ry =) Rre————"
that you did before (slides T A
23-25) e

E -0.0 Sec 1-LMM.st
Move item Blu -389 07 -00 Sec 2 - LMM.st =
Bu -389 07 -00 Mapi Sec3-LMM.st
. U pcetec 20 Red -6817 5815 -00 Pt 1
2 A te r t e I rst m a Go To XY Red -817.3 -3537 -0.0 Pt 1
. ) Red -740.7 -6405 -21.6 Pt 1
Go ToXYZ Red -7965 -699.7 -267 Pt 1
o ” G Tobiancr Red -7383 -7536 -268 Pt 1
1. Add Polygon | eoTotiaver| hod ooy 47 e b 1
Load Map -523.8 -17.7 1
2. “Add Point” in th ter of | |
S
. ot In the center oOT :
o Open
one central hole and “Stop
. ¥} Merge File...
I n g Save
. . Save As...
- Close
3. Navigator -> Montaging& § =
. ) . . ‘ Montaging & Grids ~ » Setup Corner Montage
Grids -> ”Add Grid Like Last | o - | e
O n e” Transform ltems Setup Full Montage JP—
Undo Transformation Set Grid Limits Sec1 : MMM:S‘
o . )) . Change Registration Setup Super Montage Sec 2 - MMM.st
. . Sec 3 - MMM.st
4. Check “Acquire” for this
Undo Last Shift Find Hole gular Grid... Sec 5 - MMM.st
group Algn it Rotaton.. Seca WMt
e v Sec 7 - MMM.st
. New Map from Image Add Grid Like Last One Sec 8 - MMM.st
5 D | t b d h I E d t Import Map... Divide Points into Groups Sec 9 - MMM st -
* e e e a O eS ( I Rotate Map Set Group Radius B
IVI O d e ) Adjust for Backlash Set Multi-shot Parameters... Multi ple Hole Combiner
Backlash Settings... | I Combine Points for Multi-shots... I ‘
6 IICO m b | n e POI n ts” S R St | Acquire Combine points marked as Acquire
. Set Map Acquire State Show Whole Area for All Points ~ On image in current buffe
Restore State Add Circle Polygon

Inside current polygon

Polygon from Corners

Acquire at Items... ‘
End Acquire
List Files/Series/States

3. Add points to all squares
that you want to collect

[ ¢ In same group as current point

Delete Item

Realign to Item

Display muti-shotbefore combine

Force Center Align
E Try Scaling in Realign




Start long-term collection

} U\‘T\/'igfjtr(r)lj Window Help

Read & Open... ‘
) i | Nawigator ‘ Window It
Meorge File L “ i

1. Inthe DUMMY, Navigator -> Save

Save As...

Read & Open.|

Merge File...

Close DUMMY serialEM o }
dummy” [~

Close

NSO e Montaging &sGrid »
Jndo Transform:s n

3. Inregular serialEM, Navigator -> sl Options »
End Acquire (wait for the message b
box to pop up to tell you it L
stopped) N B e

Undo Last Shift

Change Registration

Import Map...

4.  Navigator -> Read & Open -> Rolpla Moo,
naV_d.naV i Import Map...

Backlash Settings... Ll seriaIEM
5.  Uncheck “Acquire” next to the L Adjut o Backls
points that have already Restore State

COl Iecte d ! il Set Map Acquire State

End Acquire

Align with Rotation...

Backlash Settings...

Restore State

List Files/Series/States

6.  Navigator -> Save As -> nav.nav i

Delete Item

End Acquire
Realign to [tem ‘

7. Navigator -> Acquire at Items Foce Center Algn

[ \/J Try Scaling in Realign

Delete Item

Realign to Iter:

1. Run script: AcqHoles-9HolesCTEM-

IS Force Center Align

\/} Try Scaling in Realign

2. Check “Close column valves at end”
3. Check “Send email at end”

Acquire at [tems

Initial Actions afte{:\i\/loving Stage
[~ Rough eucentricity

[ Autocenter beam

[ Realign to item

[ Cook specimen

["' Fine eucentricity

[~ Autofocus [

: Primary Task

 Acquire m¢ lin’ geornt htage
= : b =

o &) <)
@ Run script ALquIes-QHiolesCTEM-IS X

| Send email atend I

I Run script after: My@ds i

e

[~ Do subset from index F to‘330

[ Skip initial stage move to item
[ Skip Z moves in initial move
I ) et alid

I Close column valves at endl

Postpor !

=align

Canc




Double check before [eaving!!

s it aligning to the holes well? If not:
* increase exposure time in Setup-> “View”
* Retake P template

I? it shooting the centers of the holes (no carbon in images)?
It not:

* Make sure the hole alignment worked, if not see above

* Redo IS template step and make sure you are in the middle of the
hole when saving

Did you set the column valves to close at end?
* You can’t actually check this without stopping it, so hopefully you
read the earlier slide!!
Are images being pulled into WARP and processed? If not:

* Check the CMD prompt and see if anything is running, double click
on transfer_serialEM.bat logo on desktop

e Check that the input directory for WARP is correct



